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Abstract

This document provides step-by-step instructions for updating an existing BizTalk solution to incorporate trading partner management. You use the solution to implement a trading partner relationship.
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Tutorial 4: Trading Partner Management             

In this tutorial, you walk through the process in which business users use Business Activity Services (BAS) to set up business partners and business agreements. You also walk through the processes that the developer uses to implement this business relationship and to route messages into and out of the BAS Web site. You modify an existing orchestration by adding new elements, such as role links, so that it can communicate with the BAS Web site. 

BAS is a Web site hosted in Microsoft Windows SharePoint Services. Business users use the BAS Web interface to set up company profiles and business agreements, and to manage business relationships. A developer, working in Microsoft Visual Studio 2005, implements the interaction of BAS profiles and relationships with the automated business process (orchestration) that is running on BizTalk Server. 

If you worked through Tutorial 1: Enterprise Application Integration, you practiced implementing business solutions from the buyer's perspective. Tutorial 1 covered enterprise application integration (EAI) between two disparate computer systems, one in the warehouse and one used for enterprise resource planning (ERP). 

This tutorial covers the supplier's side of the order fulfillment process. In this tutorial, you enable business users to manage trading partners. 

Trading partners include buyers that send purchase orders to the supplier. Each partner has predefined business contracts with the supplier. The contracts define the minimum dollar amount that is required for a purchase order to be processed. If the amount of the incoming purchase order meets or exceeds the minimum dollar amount, the supplier sends a confirmation message to the buyer; otherwise, the supplier sends a negative acknowledgment to the buyer.  

Before you begin this tutorial, you must set up your computer. For information about setting up your computer, see Before You Begin the Tutorials. 

For information about downloading a Microsoft Office Word 2003 version of the BizTalk Server 2006 Tutorials, see Step 6: Print the Tutorials.

In this Section


Lesson 1: Set Up BAS

Lesson 2: Define the Business Relationship

Lesson 3: Create the Messages and Expressions

Lesson 4: Create the Trading Partner Relationship
Lesson 1: Set Up BAS             

In this lesson, you complete several tasks to set up the Business Activity Services (BAS) site.

In this Section


Step 1: Set Up the Host Instance

Step 2: Configure IIS with the HTTP Adapter Receive Location

Step 3: Register BizTalk Server with the Business Activity Services Portal

Step 4: Create a Trusted Site in Internet Explorer
Step 1: Set Up the Host Instance             
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Time to complete: 6 minutes

Objective: In this step, you add the user account that you use for the BizTalkServerApplication host instance to the SharePoint Enabled Hosts group, and then restart the host instance.

Purpose: When you add the account that the BizTalkServerApplication host instance runs as to the SharePoint Enabled Hosts group, you make the host instance a Contributor on the SharePoint site so that it can send and receive messages from that site. Contributor is a SharePoint Services role. For more information about the Contributor role, see Windows SharePoint Services Help at http://go.microsoft.com/fwlink/?LinkId=18110.

Prerequisites

Note the following requirement before you begin this step:


Before you begin this step you must complete all of the steps in Before You Begin the Tutorials.
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To add the user account to the SharePoint Enabled Hosts group

	1.
Click Start, point to Programs, point to Administrative Tools, and then click Computer Management.

2.
In Computer Management, expand Local Users and Groups, and then click Groups.

3.
In the Groups results pane, right-click SharePoint Enabled Hosts, and then click Properties.

4.
In the SharePoint Enabled Hosts Properties dialog box, click Add.

5.
In the Select Users, Computers, or Groups dialog box, in the Enter the object name to select box, type the account name you use for the BizTalkServerApplication host instance in the form <domain>\account name, and then click OK.

6.
Click OK.
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To restart the BizTalkServerApplication host instance

	1.
Click Start, point to Programs, point to Microsoft BizTalk Server 2006, and then click BizTalk Server Administration. 

2.
In the BizTalk Server Administration console, expand BizTalk Server 2006 Administration, expand BizTalk Group, expand Platform Settings, and then click Host Instances.

3.
In the Host Instances details pane, right-click BizTalkServerApplication, and then click Restart.


What did I just do?

In this step, you added the user account that you use for the BizTalkServerApplication host instance to the SharePoint Enabled Hosts group, and then restarted the host instance, so the host instance can exchange messages with the BAS site.

Next Steps

You run a script that configures Internet Information Services (IIS) to work with the HTTP adapter receive location in Step 2: Configure IIS with the HTTP Adapter Receive Location.

See Also

Lesson 1: Set Up BAS
Step 2: Configure IIS with the HTTP Adapter Receive Location
Step 2: Configure IIS with the HTTP Adapter Receive Location             
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Time to complete: 3 minutes

Objective: In this step, you run a script that configures Internet Information Services (IIS) to work with the HTTP adapter receive location.

Purpose: This tutorial uses party resolution to match an incoming request with a trading partner. In BizTalk Server, a trading partner is considered a party. Party resolution is the process of determining who sent a particular message. In this tutorial, you use an HTTP adapter receive location for party resolution. 

You use an HTTP adapter to exchange information between BizTalk Server and an application. In this case, the HTTP adapter receive location accepts purchase order documents from the buyer. 

The HTTP adapter is an IIS Internet Server Application Programming Interface (ISAPI) extension. The IIS process hosts and controls the receive locations that use the HTTP adapter. 

The script configures IIS to work with the HTTP adapter receive location by creating an application pool and a virtual directory, allowing the BTSHttpReceive.dll to be served by IIS, and excluding the virtual directory from Windows SharePoint Services control. 

For more information about configuring IIS, see Configuring Internet Information Services for HTTP Receive Locations.

Prerequisites

Note the following requirement before you begin this step:


Before you begin this step you must complete Step 1: Set Up the Host Instance.
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To configure IIS with the HTTP adapter receive location

	1.
Click Start, and then click Run. 

2.
In the Run dialog box, type cmd, and then press ENTER.

3.
At the command prompt, type cd C:\Tutorial\Lessons\BAS\, and then press ENTER.

4.
At the command prompt, type the following command:
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Important

You must use the user name and password for the account running the Isolated host (BizTalkServerIsolatedHost).

SetupHTTPReceive.vbs /Username:<Domain or ServerName>\<UserName>/Password:<Password>
5.
Press ENTER.

6.
When the script is finished, click OK.

7.
At the command prompt, type exit, and then press ENTER.


What did I just do?

In this step, you ran a script that configured Internet Information Services (IIS) to work with the HTTP adapter receive location to enable the exchange of information between BizTalk Server and an application (accepting purchase order messages from the buyer).

Next Steps

You register a BizTalk server with the Business Activity Services (BAS) site in Step 3: Register BizTalk Server with the Business Activity Services Portal.

See Also

Lesson 1: Set Up BAS
Step 3: Register BizTalk Server with the Business Activity Services Portal
Step 4: Create a Trusted Site in Internet Explorer
Step 3: Register BizTalk Server with the Business Activity Services Portal             
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Time to complete: 4 minutes

Objective: In this step, you register a BizTalk server with the Business Activity Services (BAS) site. 

Purpose: You register a server running BizTalk Server with Business Activity Services (BAS) to associate the BizTalk Management database with the BAS Web site and create a receive location for the BAS outbox. 

This process creates a receive port named STS.Outbox that receives messages sent from the BAS outbox. 
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Important

You must be a member of the BizTalk BAS Administrators group to register a BizTalk server with BAS.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 2: Configure IIS with the HTTP Adapter Receive Location.


You must log on as a member of the BAS Administrators group.
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To register a BizTalk server

	1.
Click Start, point to Programs, point to Microsoft BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click BizTalk Servers.

3.
On the BizTalk Servers page, click Register BizTalk Server. 

4.
On the BizTalk Servers: New Item page, do the following:

Use this

To do this

Registration Name
Type BizTalk Integration Server.

BizTalk Management Database Server Name
Type <ServerName>.

BizTalk Management Database
Type BizTalkMgmtDB.

5.
Click Refresh Hosts Lists.

BAS updates the Outbox Receive Location Host box and the Parameter Service Host box with the default application.

The following figure shows the BizTalk Servers: New Item page.
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6.
Click Save and Close.


What did I just do?

In this step, you registered a BizTalk server with the Business Activity Services (BAS) site to associate the BizTalk Management database with the BAS Web site.

Next Steps

You add your server to your Trusted Sites in Step 4: Create a Trusted Site in Internet Explorer.

See Also

Lesson 1: Set Up BAS
Step 2: Configure IIS with the HTTP Adapter Receive Location
Step 4: Create a Trusted Site in Internet Explorer
Step 4: Create a Trusted Site in Internet Explorer             
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Time to complete: 4 minutes

Objective: In this step, you add your server to your Trusted Sites.

Purpose: This tutorial uses script inside an InfoPath template to save a confirmation message to the BAS outbox. The code first saves the file to your temporary directory. As a result, you may need to add your server to your Trusted Sites, and you may have to accept a security warning in InfoPath.
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Important

For security reasons, we recommend that you remove this server from your Trusted Sites after you finish the tutorial.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 3: Register BizTalk Server with the Business Activity Services Portal.
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To add your server to the list of Trusted Sites in Internet Explorer

	1.
Open Internet Explorer.

2.
On the Tools menu, click Internet Options.

3.
In the Internet Options dialog box, on the Security tab, click Trusted Sites, and then click Sites.

4.
In the Trusted sites dialog box, do the following:
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Note

You must clear the Require server verification (https:) for all sites in this zone check box before you can add the Web site.

Use this

To do this

Require server verification (https:) for all sites in this zone 
Clear the check box.

Add this Web site to the zone
Type http://<ServerName>.
5.
Click Add, and then click Close.

6.
In the Internet Options dialog box, click OK. 


What did I just do?

In this step, you added your server to your Trusted Sites. This facilitates running the scripts that are part of the templates provided by the BAS site. 

Next Steps

You modify an existing orchestration by creating role links, which define the business relationship between your organization and your trading partner's organization in Lesson 2: Define the Business Relationship.

See Also

Lesson 1: Set Up BAS
Step 2: Configure IIS with the HTTP Adapter Receive Location
Step 3: Register BizTalk Server with the Business Activity Services Portal
Lesson 2: Define the Business Relationship             

In this lesson, you modify an existing orchestration by creating role links, which define the business relationship between your organization and your trading partner's organization.

You can think of role links as paired ports. One port in a role link is the seller, and the other port is the buyer. For each role link, you must define a port type, a role link type, and the role link itself.

A role link type is a property that characterizes the relationship between two services or orchestrations by defining the part played by each of the services in the relationship and specifying the port types provided by each role.

Role link types represent service links in the Business Process Execution Language for Web Services (BPEL4WS) specification. Service links define and represent a business relationship such as an interaction between a buyer and seller. When you specify a business relationship in an agreement addendum in the BAS portal, you select a role link type.

A role is a collection of port types that either uses a service or implements a service. A role defines how parties interact with orchestrations. For example, an orchestration might use the role of Shipper. The Shipper has one or two parties associated with it. When the orchestration decides which shipping company to use to ship an item, it compares the prices of the parties in the Shipper role.

A port type is a property that defines the set of message interaction patterns, called operations, permitted at that endpoint. An operation can be one-way, in which case one message is sent or received, or it can be request-response, in which case a message is sent (or received) and a response is received (or sent).

An operation is a request or request-response pairing on a port, associated with either a send or receive action.

A role link is the relationship between roles defined by the message and port types used in the interactions in both directions.

In this Section


Step 1: Open the OrderProcess Solution

Step 2: Create the Business Relationship Role Link

Step 3: Create the Business Policy Role Link

Step 4: Create the SendDocumentsToSharePoint Role Link

Step 5: Create the ReceiveDocumentsFromOutbox Role Link

Step 6: Create the Structured Parameter Schema for the Business Policy
Step 1: Open the OrderProcess Solution             
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Time to complete: 3 minutes

Objective: In this step, you use Visual Studio 2005 to open the BizTalk solution that contains the orchestration that represents the order process.

Purpose: The orchestration in the OrderProcess solution represents and automates a business process. In this lesson, you will modify the orchestration to work with BAS.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 4: Create a Trusted Site in Internet Explorer.


You must log on as a member of the BizTalk Server Administrators group.
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To open the OrderProcess solution 

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.


What did I just do?

In this step, you used Visual Studio 2005 to open the BizTalk solution that contains the orchestration that represents the order process.

Next Steps

You create the Purchasing role link in Step 2: Create the Business Relationship Role Link.

See Also

Lesson 2: Define the Business Relationship
Step 2: Create the Business Relationship Role Link
Step 3: Create the Business Policy Role Link
Step 4: Create the SendDocumentsToSharePoint Role Link
Step 5: Create the ReceiveDocumentsFromOutbox Role Link
Step 6: Create the Structured Parameter Schema for the Business Policy
Step 2: Create the Business Relationship Role Link             
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Time to complete: 10 minutes

Objective: In this task, you create a role link type with two roles: Buyer and Seller. Each role has a corresponding port type. You create the port type in the next task.

Purpose: The Purchasing role link connects the Buyer port and the Seller port. You must complete four tasks to create the Purchasing role link:

1.
Create the role link type and the associated roles. 

2.
Create and configure the port type for the Seller role.

3.
Create and configure the port type for the Buyer role.

4.
Create the Purchasing role link that connects the ports of the roles.

You create the port types for the roles you created in the previous task. Each port type contains request operations that have message types. The Seller port type has a request operation called PO. The PO operation has a message type defined by the PurchaseOrder schema.

The Buyer port type has a request operation called Confirmation. The Confirmation operation has a message type defined by the Confirmation schema. The Buyer port type also has a request operation called NegativeAck. The NegativeAck operation has a message type defined by the NAK schema.

The Purchasing role link connects two ports: the Buyer port and the Seller port.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 1: Open the OrderProcess Solution.


You must log on as a member of the BizTalk Server Administrators group.

[image: image19.png]


To create the PurchasingType role link type

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In the Orchestration View window, expand Types, right-click Role Link Types, and then click New Role Link Type.
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Note

The Orchestration View window appears next to the Solution Explorer window. If the Orchestration View window is not available, on the View menu, point to Other Windows, and then click Orchestration View.

6.
Right-click RoleLinkType_1 and then click Properties Window.
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Note

The Properties pane is a grid control. You must click in the property row to expose the property control. A control is a device you use to select options, such as a drop-down list.

7.
In the Properties pane, change the value of the Identifier property to PurchasingType and press ENTER. 
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To create the PurchasingType roles

	1.
Expand PurchasingType, right-click Role_1, and then click Properties Window.

2.
In the Properties pane, change the value of the Identifier property toSeller, and then press ENTER. 

3.
Right-click PurchasingType, and then click New Role. 

4.
Right-click Role_1, and then click Properties Window.

5.
In the Properties pane, change the value of the Identifier property to Buyer, and then press ENTER.
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To create the Seller port type

	1.
In the Orchestration View window, right-click Seller, and then click Add Port Type. 

2.
On the Welcome to the Port Type Wizard page, click Next. 

3.
On the Select a Port Type or create a new Port Type page, do the following:

Use this

To do this

Select the port type to be used for this port
Select the Create a new Port Type option.

Port Type Name
Type SellerPortType.

Communication Pattern
Select the One-Way option.

Access Restrictions
Select the Public-no limit option.

4.
Click Next.

5.
On the Completing the Port Wizard page, click Finish. 
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To configure the Seller operation

	1.
In the Orchestration View window, expand Port Types, expand SellerPortType, right-click Operation _1, and then click Properties Window.

2.
In the Properties pane, change the value of the Identifier property to PO, and then press ENTER. 

3.
Expand PO, right-click Request, and then click Properties Window.

4.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.PurchaseOrder. 
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To create the Buyer port type

	1.
In the Orchestration View window, expand Role Link Types, expand PurchasingType, right-click Buyer, and then click Add Port Type. 

2.
On the Welcome to the Port Type Wizard page, click Next. 

3.
On the Select a Port Type or create a new Port Type page, do the following:

Use this

To do this

Select the port type to be used for this port
Select the Create a new Port Type option.

Port Type Name
Type BuyerPortType.

Communication Pattern
Select the One-Way option.

Access Restrictions
Select the Public-no limit option.

4.
Click Next.

5.
On the Completing the Port Wizard page, click Finish. 
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To configure the Buyer operations

	1.
In the Orchestration View window, expand Port Types, expand BuyerPortType, right-click Operation _1, and then click Properties Window.

2.
In the Properties pane, change the value of the Identifier property to Confirmation, and then press ENTER.

3.
Expand Confirmation, right-click Request, and then click Properties Window.

4.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.Confirmation.
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Note

The Properties pane is a grid control. You must click in the property row to expose the property control. A control is a device you use to select options, such as a drop-down list.

5.
In the Orchestration View window, expand Port Types, right-click BuyerPortType, and then click New Operation.

6.
Right-click Operation_1, and then click Properties Window.

7.
In the Properties pane, change the value of the Identifier property to NegativeAck, and then press ENTER.

8.
Expand NegativeAck, right-click Request, and then click Properties Window. 

9.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.NAK.
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To create the Purchasing role link

	1.
In Orchestration Designer, right-click the left Port Surface and then click New Role Link. 

2.
On the Welcome to the Role Link Wizard page, click Next. 

3.
On the Role Link Name page, in the Name box, type Purchasing, and then click Next. 

4.
On the Role Link Type page, do the following: 

Use this

To do this

Would you like to create a new type for this Role Link, or reuse an existing Role Link type that has already been defined?
Select the Use an existing Role Link Type option to use an existing role link type.

Role Link Type Name
From the drop-down list, select OrderProcess.PurchasingType.

5.
Click Next.

6.
On the Role Identification page, from the Which role will this orchestration implement to receive and process messages from partners? drop-down list, select Seller, and then click Next.
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Note

This identifies the role this orchestration will implement. 

7.
On the Role Link Usage page, select the I will be receiving the first message through my implemented role option, and then click Finish. 

8.
On the File menu, click Save All.


What did I just do?

In this task, you created a role link type with two roles: Buyer and Seller. Each role has a corresponding port type. 

Next Steps

You create a role link that uses the BAS TPPubWS Web service to return values at run time in Step 3: Create the Business Policy Role Link.

See Also

Lesson 2: Define the Business Relationship
Step 1: Open the OrderProcess Solution
Step 3: Create the Business Policy Role Link
Step 4: Create the SendDocumentsToSharePoint Role Link
Step 5: Create the ReceiveDocumentsFromOutbox Role Link
Step 6: Create the Structured Parameter Schema for the Business Policy
Step 3: Create the Business Policy Role Link             
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Time to complete: 7 minutes

Objective: In this step, you create a role link that uses the BAS TPPubWS Web service to return values at run time.

Purpose: Business Activity Services-enabled orchestrations must use predefined names for the role link types, roles, and port types that interact with the Windows SharePoint Services collaboration site and the trading partner publishing Web service (TPPubWS). For more information about the predefined names, see Business Activity Services Messaging Infrastructure.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 2: Create the Business Relationship Role Link.


You must log on as a member of the BizTalk Server Administrators group.
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Add a reference to the BizTalk Server RoleLinkTypes assembly

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, expand the OrderProcess project, right-click References, and then click Add Reference.

5.
In the Add Reference dialog box, on the Browse tab, navigate to C:\program files\Microsoft BizTalk Server 2006, select Microsoft.BizTalk.KwTpm.RoleLinkTypes.dll, click Add, and then click OK.

The following figure shows the Add Reference dialog box before you click OK.
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Create the ParameterWebService role link

	1.
In Solution Explorer, expand the OrderProcess project, and then double-click OrderService.odx.

2.
In Orchestration Designer, on the orchestration design surface, right-click the left Port Surface, and then click New Role Link.

3.
In the Role Link Wizard, on the Welcome to the Role Link Wizard page, click Next.

4.
On the Role Link Name page, in the Name box, type ParameterWebService, and then click Next.

5.
On the Role Link Type page, do the following:

Use this

To do this

Would you like to create a new type for this Role Link, or reuse an existing Role Link type that has already been defined?
Select the Use an existing Role Link Type option.

Role Link Type Name
From the drop-down list, select Microsoft.BizTalk.KwTpm.BasParameterLT.

6.
Click Next.

7.
On the Role Link Usage page, select the Consumer Role: I will be sending the first message option, and then click Finish.

The following figure shows the ParameterWebService role link.
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What did I just do?

In this step, you created a role link that uses the BAS TPPubWS Web service to return values at run time.

Next Steps

You create a role link that integrates the orchestration with the Inbox and Sent Items folders available for each trading partner in BAS in Step 4: Create the SendDocumentsToSharePoint Role Link.

See Also

Lesson 2: Define the Business Relationship
Step 1: Open the OrderProcess Solution
Step 2: Create the Business Relationship Role Link
Step 4: Create the SendDocumentsToSharePoint Role Link
Step 5: Create the ReceiveDocumentsFromOutbox Role Link
Step 6: Create the Structured Parameter Schema for the Business Policy
Step 4: Create the SendDocumentsToSharePoint Role Link             
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Time to complete: 10 minutes

Objective: In this step, you create a role link that integrates the orchestration with the Inbox and Sent Items folders available for each trading partner in BAS.

Purpose: The SendDocumentsToSharePoint role link sends documents to the BAS site.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 3: Create the Business Policy Role Link.


You must log on as a member of the BizTalk Server Administrators group.
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To create the sendToInboxPT role link type

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In the Orchestration View window, expand Types, right-click Role Link Type, and then click New Role Link Type.

6.
Right-click RoleLinkType_1, and then click Properties Window.

7.
In the Properties pane, change the value of the Identifier property to sendBusinessDocumentsLT, and then press ENTER.
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Important

To make BAS recognize this as a special role link type, the name must be exactly as shown. It is case sensitive.

8.
In the Orchestration View window, expand sendBusinessDocumentsLT, right-click Role_1, and then click Properties Window.

9.
In the Properties pane, change the value of the Identifier property to sender, and then press ENTER. 
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Important

To make BAS recognize this role, the name must be exactly as shown. It is case sensitive.

10.
Right-click sender, and then click Add Port Type. 

11.
On the Welcome to the Port Type Wizard page, click Next. 

12.
On the Select a Port Type or create a new Port Type page, do the following:

Use this

To do this

Select the port type to be used for this port
Select the Create a new Port Type option.

Port Type Name
Type sendToInboxPT.
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Important

To make BAS recognize this as a special port type, the name must be exactly as shown. It is case sensitive.

Communication Pattern
Select the One-Way option.

Access Restrictions
Select the Public - no limit option.

13.
Click Next.

14.
On the Completing the Port Wizard page, click Finish. 
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To add a second port type to the sender role

	1.
In the Orchestration View window, right-click sender, and then click Add Port Type. 

2.
On the Welcome to the Port Type Wizard page, click Next. 

3.
On the Select a Port Type or create a new Port Type page, do the following:

Use this

To do this

Select the port type to be used for this port
Select the Create a new Port Type option.

Port Type Name
Type sendToSentItemsPT.
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Important

To make BAS recognize this as a special port type, the name must be exactly as shown. It is case sensitive.

Communication Pattern
Select the One-Way option.

Access Restrictions
Select the Public - no limit option.

4.
Click Next.

5.
On the Completing the Port Wizard page, click Finish. 
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To configure the port types for sending documents into BAS

	1.
In the Orchestration View window, expand PortTypes, expand sendToInboxPT, right-click Operation_1, and then click Properties Window.

2.
In the Properties pane, change the value of the Identifier property to PO, and then press ENTER.

3.
Expand PO, right-click Request, and then click Properties Window. 

4.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.PurchaseOrder.

The following figure shows the Orchestration View window and Properties pane.

[image: image43.png]Send confirmation 5
Send Ak

B Types

£ Port Types

SuyerpartType
SelerportTye
=5 sendTolnboxPT
Ziro
% Request
(® sendTosentItemspT
2 Fukipar Message Types
2 Conslaton Types
(=i Role Link Types
5.7 puchasngType
52 buyer

3 euperortype
[ e -
‘ 5

g0k Explrer | B Orchestration View

ax
Request Operation essage 5
EElE

Desarpton

Wessage Drection | Reauest

Message Type  Onderrocess PuchaseOr

Nome Reauest

ObjectType Operation essage

Report To Analyst True.




5.
In the Orchestration View window, expand PortTypes, expand sendToSentItemsPT, right-click Operation_1, and then click Properties Window.

6.
In the Properties pane, change the value of the Identifier property to Confirmation, and then press ENTER.

7.
Expand Confirmation, right-click Request, and then click Properties Window.

8.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.Confirmation.

The following figure shows the Orchestration View Window and Properties pane.
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9.
In the Orchestration View window, right-click sendToSentItemsPT, and then click New Operation.

10.
Right-click Operation_1, and then click Properties Window.

11.
In the Properties pane, change the value of the Identifier property to NegativeAck, and then press ENTER.

12.
Expand NegativeAck, right-click Request, and then click Properties Window. 

13.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.NAK.

The following figure shows the Orchestration View Window and Properties pane.
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To create the SendDocumentsToSharePoint role link

	1.
In Orchestration Designer, right-click the right Port Surface, and then click New Role Link. 

2.
On the Welcome to the Role Link Wizard page, click Next. 

3.
On the Role Link Name page, in the Name box, type SendDocumentsToSharePoint, and then click Next. 

4.
On the Role Link Type page, do the following:

Use this

To do this

Would you like to create a new type for this Role Link, or reuse an existing Role Link type that has already been defined?
Select the Use an existing Role Link Type option.

Role Link Type Name
From the drop-down list, select OrderProcess.sendBusinessDocumentsLT.

5.
Click Next. 

6.
On the Role Link Usage page, select the Consumer Role:I will be sending the first message option, and then click Finish. 

The following figure shows the SendDocumentsToSharePoint role link.
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7.
On the File menu, click Save All.


What did I just do?

In this step, you created a role link that integrates the orchestration with the Inbox and Sent Items folders available for each trading partner in BAS.

Next Steps

You create a role link that integrates the orchestration with the BAS outbox in Step 5: Create the ReceiveDocumentsFromOutbox Role Link.

See Also

Lesson 2: Define the Business Relationship
Step 1: Open the OrderProcess Solution
Step 2: Create the Business Relationship Role Link
Step 3: Create the Business Policy Role Link
Step 5: Create the ReceiveDocumentsFromOutbox Role Link
Step 6: Create the Structured Parameter Schema for the Business Policy
Step 5: Create the ReceiveDocumentsFromOutbox Role Link             
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Time to complete: 7 minutes

Objective: In this step, you create a role link that integrates the orchestration with the BAS outbox.

Purpose: Integrating the orchestration with the BAS outbox lets the orchestration move messages to the BAS outbox. 

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 4: Create the SendDocumentsToSharePoint Role Link.


You must log on as a member of the BizTalk Server Administrators group.
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To create the receiveBusinessDocumentsLT role link type

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In the Orchestration View window, expand Types, right-click Role Link Types, and then click New Role Link Type.

6.
Right-click RoleLinkType_1, and then click Properties Window.
7.
In the Properties pane, change the value of the Identifier property to receiveBusinessDocumentsLT, and then press ENTER.
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Important

To make BAS recognize this as a special role link type, the name must be exactly as shown. It is case sensitive.

8.
In the Orchestration View window, expand receiveBusinessDocumentsLT, right-click Role_1, and then click Properties Window.
9.
In the Properties pane, change the value of the Identifier property toreceiver, and then press ENTER.
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Important

To make BAS recognize this role, the name must be exactly as shown. It is case sensitive.

10.
In the Orchestration View window, right-click receiver, and then click Add Port Type. 

11.
On the Welcome to the Port Type Wizard page, click Next. 

12.
On the Select a Port Type or create a new Port Type page, do the following:

Use this

To do this

Select the port type to be used for this port
Select the Create a new Port Type option.

Port Type Name
Type receiveFromOutboxPT.
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Important

To make BAS recognize this as a special port type, the name must be exactly as shown. It is case sensitive.

Communication Pattern
Select the One-Way option.

Access Restrictions
Select the Public - no limit option.

13.
Click Next.

14.
On the Completing the Port Wizard page, click Finish. 
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To configure a port type for receiving documents from BAS

	1.
In the Orchestration View window, expand PortTypes, expand receiveFromOutboxPT, right-click Operation _1, and then click Properties Window.

2.
In the Properties pane, change the value of the Identifier property to Confirmation, and then press ENTER.

3.
Expand Confirmation, right-click Request, and then click Properties Window. 

4.
In the Properties pane, in the Message Type drop-down list, expand Schemas, and then select OrderProcess.Confirmation. 

The following figure shows the Orchestration View window and the Properties pane.
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To create the ReceiveDocumentsFromOutbox role link

	1.
In Orchestration Designer, right-click the right Port Surface and then click New Role Link. 

2.
On the Welcome to the Role Link Wizard page, click Next. 

3.
On the Role Link Name page, in the Name box, type ReceiveDocumentsFromOutbox, and then click Next. 

4.
On the Role Link Type page, do the following:

Use this

To do this

Would you like to create a new type for this Role Link, or reuse an existing Role Link type than has already been defined?
Select the Use an existing Role Link Type option.

Role Link Type Name
From the drop-down list, select OrderProcess.receiveBusinessDocumentsLT.

5.
Click Next. 

6.
On the Role Link Usage page, select the Provider Role:I will be receiving the first message option, and then click Finish. 

7.
On the File menu, click Save All.


What did I just do?

In this step, you created a role link that integrates the orchestration with the BAS outbox.

Next Steps

You create the schema for the business policy, and promote the schema fields in Step 6: Create the Structured Parameter Schema for the Business Policy.

See Also

Lesson 2: Define the Business Relationship
Step 1: Open the OrderProcess Solution
Step 2: Create the Business Relationship Role Link
Step 3: Create the Business Policy Role Link
Step 4: Create the SendDocumentsToSharePoint Role Link
Step 6: Create the Structured Parameter Schema for the Business Policy
Step 6: Create the Structured Parameter Schema for the Business Policy             
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Time to complete: 6 minutes

Objective: In this step, you create the schema for the business policy and promote the schema fields.

Purpose: You created the Business Policy role link in Step 3: Create the Business Policy Role Link. In this step, you create the schema for the business policy and promote the schema fields so that you can use them in messages.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 5: Create the ReceiveDocumentsFromOutbox Role Link.


You must log on as a member of the BizTalk Server Administrators group.

[image: image57.png]


To create the schema file

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, right-click OrderProcess, point to Add, and then click NewItem.

5.
In the Add New Item – OrderProcess dialog box, do the following:

Use this

To do this

Categories
Click Schema Files.

Templates
Click Schema.

Name
Type PurchasingParameters.xsd.

6.
Click Add.
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To define the schema

	1.
In Solution Explorer, double-click PurchasingParameters.xsd.

2.
In BizTalk Editor, in the PurchasingParameters schema tree control on the left, right-click the <Schema> node, and then click Properties.

3.
In the Properties pane, click the Schema Editor Extensions ellipsis […].

4.
In the Schema Editor Extension dialog box, select the BAS Parameter Schema Extension check box, and then click OK.

The following figure shows the Schema Editor Extension dialog box.
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5.
In the tree control, right-click the Root node, and then click Properties.

6.
In the Properties pane, change the value of the Node Name property to PurchaseOrder, and then press ENTER.

7.
In the tree control, right-click PurchaseOrder, point to Insert Schema Node, and then click Child Field Element.

The following figure shows the shortcut menu for PurchaseOrder.
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8.
In the tree control, type MinPOAmount as the field name, and then press ENTER.

9.
In the tree control, right-click MinPOAmount, and then click Properties. 

10.
In the Properties pane, from the Data Type drop-down list, select xs:float.

The following figure shows the MinPOAmount Properties pane.
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11.
In the tree control, right-click PurchaseOrder, point to Insert Schema Node, and then click Child Field Element.

12.
In the tree control, type DiscountRate as the field name, and then press ENTER.

13.
In the tree control, right-click DiscountRate, and then click Properties.

14.
In the Properties pane, from the Data Type drop-down list, select xs:integer.

The following figure shows the DiscountRate Properties pane.
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15.
In the tree control, right-click the PurchaseOrder node, and then click Properties. 

16.
In the Properties pane, from the Role Link Types drop-down list, select the check box next to OrderProcess.PurchasingType, and then press ENTER.

The following figure shows the PurchaseOrder Properties pane.
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To promote the schema fields

	1.
In BizTalk Editor, in the PurchasingParameters schema tree control, right-click the <Schema> node, and then click Properties.

2.
In the Properties pane, click the Promote Properties ellipsis […].

3.
In the Promote Properties dialog box, on the Distinguished Fields tab, in the tree control, expand PurchaseOrder, click MinPOAmount, and then click Add.

4.
In the Promote Properties dialog box, on the Distinguished Fields tab, in the tree control, click DiscountRate, click Add, and then click OK.

The following figure shows the Promote Properties dialog box.
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5.
On the File menu, click Save All Files.


What did I just do?

In this step, you created the schema for the business policy and promoted the schema fields.

Next Steps

You add messages and expressions to the orchestration and connect the role links to the action shapes in Lesson 3: Create the Messages and Expressions.

See Also

Lesson 2: Define the Business Relationship
Step 1: Open the OrderProcess Solution
Step 2: Create the Business Relationship Role Link
Step 3: Create the Business Policy Role Link
Step 4: Create the SendDocumentsToSharePoint Role Link
Step 5: Create the ReceiveDocumentsFromOutbox Role Link
Lesson 3: Create the Messages and Expressions             

In this lesson, you add messages and expressions to the orchestration and connect the role links to the action shapes.

In this Section


Step 1: Create the Messages for the Structured Parameter

Step 2: Connect the Role Link Ports

Step 3: Create the Construct PurchaseParameterMsg Message

Step 4: Create the ParamRequestMsg Message

Step 5: Create the Calculate PO Info Expression

Step 6: Set the File Name for the Inbox Message

Step 7: Build and Deploy the Solution
Step 1: Create the Messages for the Structured Parameter             
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Time to complete: 8 minutes

Objective: In this step, you create the message instance variables for the structured parameter schema.

Purpose: You use the message instance variables to associate the schema the orchestration associates with each instance of a message.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 6: Create the Structured Parameter Schema for the Business Policy.


You must log on as a member of the BizTalk Server Administrators group.
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To create the PurchaseParameterMsg message instance variable

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In the Orchestration View window, right-click Messages, and then click New Message.

6.
In the Orchestration View window, right-click Message_1, and then click Properties Window.

7.
In the Properties pane, do the following:

Use this

To do this

Identifier
Type PurchaseParameterMsg, and then press ENTER.

Message Type
In the drop-down list, expand Schemas, and then click OrderProcess.PurchasingParameters.
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To create the request message instance variable

	1.
In the Orchestration View window, right-click Messages, and then click New Message.

2.
In the Orchestration View window, right-click Message_1, and then click Properties Window.

3.
In the Properties pane, do the following:

Use this

To do this

Identifier
Type ParamRequestMsg, and then press ENTER.

Message Type
In the drop-down list, expand Web Message Types, and then click Select from referenced assembly.

4.
In the Select Artifact Type dialog box, expand the Microsoft.BizTalk.KwTpm.RoleLinkTypes assembly, and then click the Microsoft.BizTalk.KwTpm.TPPubWS.TPPubWS_ node.

5.
In the right pane, select GetStructuredParameterValue_request, and then click OK.
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To create the response message instance variable

	1.
In the Orchestration View window, right-click Messages, and then click New Message.

2.
In the Orchestration View window, right-click Message_1, and then click Properties Window.

3.
In the Properties pane, do the following:

Use this

To do this

Identifier
Type ParamResponseMsg, and then press ENTER.

Message Type
In the drop-down list, expand Web Message Types, and then click Select from referenced assembly.

4.
In the Select Artifact Type dialog box, expand the Microsoft.BizTalk.KwTpm.RoleLinkTypes assembly, and then click the Microsoft.BizTalk.KwTpm.TPPubWS.TPPubWS_ node.

5.
In the right pane, select GetStructuredParameterValue_response, and then click OK.
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To associate the Construct request to retrieve structured parameter value shape with the ParamRequestMsg message instance variable

	1.
In Orchestration Designer, on the orchestration design surface, right-click the Construct request to retrieve structured parameter value shape, and then click Properties Window.

2.
In the Properties pane, in the Messages Constructed drop-down list, select the ParamRequestMsg check box, and then press ENTER.
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To associate the Construct PurchaseParameterMsg shape with the PurchaseParameterMsg message instance variable

	1.
In Orchestration Designer, on the orchestration design surface, right-click the Construct PurchaseParameterMsg shape, and then click Properties Window.

2.
In the Properties pane, in the Messages Constructed drop-down list, select the PurchaseParameterMsg check box, and then press ENTER.
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To associate the Request Value shape with the ParamRequestMsg message instance variable

	1.
In Orchestration Designer, on the orchestration design surface, right-click the Request Value shape, and then click Properties Window.

2.
In the Properties pane, in the Message drop-down list, select ParamRequestMsg, and then press ENTER.


[image: image73.png]


To associate the Receive Value shape with the ParamResponseMsg message instance variable

	1.
In Orchestration Designer, on the orchestration design surface, right-click the Receive Value shape, and then click Properties Window.

2.
In the Properties pane, in the Message drop-down list, select ParamResponseMsg, and then press ENTER.


What did I just do?

In this step, you created the message instance variables for the structured parameter schema.

Next Steps

You connect the role link ports to the orchestration Send and Receive shapes in Step 2: Connect the Role Link Ports.

See Also

Lesson 3: Create the Messages and Expressions
Step 2: Connect the Role Link Ports
Step 3: Create the Construct PurchaseParameterMsg Message
Step 4: Create the ParamRequestMsg Message
Step 5: Create the Calculate PO Info Expression
Step 6: Set the File Name for the Inbox Message
Step 7: Build and Deploy the Solution
Step 2: Connect the Role Link Ports             
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Time to complete: 5 minutes

Objective: In this step, you connect the role link ports to the orchestration Send and Receive shapes.

Purpose: Connecting ports to the Send and Receive shapes tells the orchestration where it receives messages from and where it sends messages to. You defined logical (also known as early binding) role link ports for the orchestration in Lesson 2: Define the Business Relationship. You will define the physical ports the orchestration uses in Step 5: Configure and Start the Application.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 1: Create the Messages for the Structured Parameter.


You must log on as a member of the BizTalk Server Administrators group.
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To connect the role link ports to the Send and Receive shapes

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In Orchestration Designer, select the green handle of a role link port and drag it to the green handle of a Receive shape, or to the green handle of a Send shape. 

The following table shows you which ports to connect to which shapes.

Connect this role link port

To this shape

SellerPortType - PO - Request
Receive PO
BuyerPortType - Confirmation - Request
Send Confirmation to Partner 
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Note

This is the lower-left shape of the orchestration.

BuyerPortType - NegativeAck - Request
Send NAK to Partner 
TpPubWS - GetStructured ParameterValue -Request
Request Value  
TpPubWS - GetStructured ParameterValue - Response
Receive Value
sendToInboxPT – PO - Request
Send PO to Inbox
sendToSentItemsPT – Confirmation - Request
Send Confirmation to Sent Items
sendToSentItemsPT – NegativeAck - Request
Send NAK to Sent Items
receiveFromOutboxPT – Confirmation - Request
Receive Confirmation from Outbox
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Note

After you connect the role link ports to the orchestration shapes, some orchestration shapes show an insufficient configuration Smart Tag. You will add the missing expressions later in this lesson.

The following figure shows the Smart Tag.
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6.
On the File menu, click Save All.


What did I just do?

In this step, you connected the role link ports to the orchestration Send and Receive shapes.

Next Steps

You create the expression that generates the PurchaseParameterMsg message in Step 3: Create the Construct PurchaseParameterMsg Message.

See Also

Lesson 3: Create the Messages and Expressions
Step 1: Create the Messages for the Structured Parameter
Step 3: Create the Construct PurchaseParameterMsg Message
Step 4: Create the ParamRequestMsg Message
Step 5: Create the Calculate PO Info Expression
Step 6: Set the File Name for the Inbox Message
Step 7: Build and Deploy the Solution
Step 3: Create the Construct PurchaseParameterMsg Message             
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Time to complete: 5 minutes

Objective: In this step, you create the expression that generates the PurchaseParameterMsg message.

Purpose: The expression associates the values returned by the structured parameter in the ParameterResponse message with the orchestration.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 2: Connect the Role Link Ports.


You must log on as a member of the BizTalk Server Administrators group.
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To create the message for the Construct PurchaseParameterMsg shape

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
On the orchestration design surface, in the Construct PurchaseParameterMsg shape, double-click the interior Construct PurchaseParameterMsg shape, and then in the Expression Editor, type the following:
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Note

To copy the expression from the documentation, click Copy Code in this topic. Using other methods to copy the expression can result in copying hidden characters into the Expression Editor that can cause problems when you try to build the project.

parameterXmlDoc = ParamResponseMsg.GetStructuredParameterValueResult;

PurchaseParameterMsg = parameterXmlDoc;

6.
Click OK to close the Expression Editor.


What did I just do?

In this step, you created the expression that generates the PurchaseParameterMsg message.

Next Steps

You create the message that returns the values from the structured parameters in Step 4: Create the ParamRequestMsg Message. 

See Also

Lesson 3: Create the Messages and Expressions
Step 1: Create the Messages for the Structured Parameter
Step 2: Connect the Role Link Ports
Step 4: Create the ParamRequestMsg Message
Step 5: Create the Calculate PO Info Expression
Step 6: Set the File Name for the Inbox Message
Step 7: Build and Deploy the Solution
Step 4: Create the ParamRequestMsg Message             
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Time to complete: 7 minutes

Objective: In this step, you create the message that returns the values from the structured parameters.

Purpose: At run time, your orchestration makes a call to the BAS TpPubWS Web service to retrieve the values defined for the structured parameters associated with the OrderProcess.PurchasingType role link type. You can assign the retrieved values to a System.Xml.XmlDocument object and cast them back to a message of the original schema type: Purchasing Parameters.

In the message that is sent to the Web service, you need to set six parameter values:


orchestrationName. This is the fully qualified name of the current orchestration.


orchestrationAssemblyStrongName. This is the assembly strong name of the current assembly.


parameterSchemaFullName. This is the fully qualified parameter schema name.


partnerID. This is the ID of the partner for which parameter values are retrieved. 

In this example, we extract the partner ID from the purchase order message. 


roleLinkTypeAssemblyStrongName. This is the strong name of the assembly in which you defined the role link type.


roleLinkTypeFullName. This is the name of the role link type that you associated with the parameter schema. 
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Note

You must always define a parameter schema in the same assembly where you define the associated role link types.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 3: Create the Construct PurchaseParameterMsg Message.


You must log on as a member of the BizTalk Server Administrators group.
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To create the ParamRequestMsg Message

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In Orchestration Designer, on the design surface, in the Construct request to retrieve structured parameter value shape, double-click Initialize ParamRequestMsg to open BizTalk Expression Editor.
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Note

The Construct request to retrieve structured parameter value shape is the first shape inside of the Get minimum PO amount for current partner shape.

6.
In BizTalk Expression Editor, type the following expression:
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Note

This expression contains a reference to the public key token for the assembly. You will not have the public key token until you build the assembly, so for now you are using an empty reference (xxxxxxxxxxxxxxxx). You will update the expression with the public key token in Step 7: Build and Deploy the Solution.

ParamRequestMsg.orchestrationAssemblyStrongName = "OrderProcess, Version=1.0.0.0, Culture=neutral, PublicKeyToken=xxxxxxxxxxxxxxxx";

ParamRequestMsg.orchestrationName = "OrderProcess.OrderService";

ParamRequestMsg.parameterSchemaFullName = "OrderProcess.PurchasingParameters";

ParamRequestMsg.partnerId = sourceParty.Name;

ParamRequestMsg.roleLinkTypeAssemblyStrongName = "OrderProcess, Version=1.0.0.0, Culture=neutral, PublicKeyToken=xxxxxxxxxxxxxxxx";

ParamRequestMsg.roleLinkTypeFullName = "OrderProcess.PurchasingType";

7.
Click OK to close the Expression Editor.

8.
On the File menu, click Save All.


What did I just do?

In this step, you created the message that returns the values from the structured parameters.

Next Steps

You add the expression to the Calculate PO Info shape in Step 5: Create the Calculate PO Info Expression.

See Also

Lesson 3: Create the Messages and Expressions
Step 1: Create the Messages for the Structured Parameter
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Time to complete: 5 minutes

Objective: In this step you add the expression to the Calculate PO Info shape.

Purpose: The Calculate PO expression calculates the value of a purchase order, including the discount rate and minimum amount defined in the structured parameter schema. The discount rate and minimum amount are collected on the BAS site in the Agreement template, on the Addendums tab.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 4: Create the ParamRequestMsg Message.


You must log on as a member of the BizTalk Server Administrators group.
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To create the Calculate PO Info expression

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, double-click OrderService.odx. 

5.
In Orchestration Designer, on the design surface, double-click the Calculate PO Info shape, and then in the Expression Editor, type the following:
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Note

To copy the expression from the documentation, click Copy Code in this topic. Using other methods to copy the expression can result in copying hidden characters into the Expression Editor that can cause problems when you try to build the project.

minPOAmountValue = PurchaseParameterMsg.MinPOAmount;

discountRate = (System.Double)PurchaseParameterMsg.DiscountRate / 100;

purchaseTotal = PurchaseOrderMsg(OrderProcess.total);

purchaseTotal = purchaseTotal - (purchaseTotal * discountRate);

6.
Click OK.


What did I just do?

In this step you added the expression to the Calculate PO Info shape.

Next Steps

You set the file name for messages sent to the BAS site Inbox in Step 6: Set the File Name for the Inbox Message.

See Also
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Time to complete: 6 minutes

Objective: In this step, you set the file name for messages sent to the BAS site Inbox.

Purpose: To guarantee that a particular message appears in the Inbox only one time, you set the file name property for the message before the BizTalk Host sends it to the Inbox. If the BizTalk Host sends this message more than once to the Inbox — for example, in an error condition in which the host retries the send — the new message replaces the existing message with the same file name in the Inbox. If you did not create this file name and instead relied on a unique message ID created by BizTalk Server, the same message could appear more than once in the Inbox (but with different file names).

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 5: Create the Calculate PO Info Expression.


You must log on as a member of the BizTalk Server Administrators group.
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To set the file name for the Inbox message

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, expand OrderProcess, right-click References, and then click Add Reference. 

5.
In the Add Reference dialog box, on the Browse tab, navigate to <BizTalk Server installation directory>\BAS Runtime Components, select Microsoft.BizTalk.KwTpm.StsDefaultPipelines.dll, click Add, and then click OK. 

6.
In the message box, click OK.

7.
In Orchestration Designer, on the design surface, in the Construct Inbox Message shape, double-click Assign Inbox Filename toopen the expression editor. 

8.
In BizTalk Expression Editor, type the following expression: 

PurchaseOrderMsgWithInboxFilename = PurchaseOrderMsg;

PurchaseOrderMsgWithInboxFilename(WSS.Filename)

 = "PurchaseOrder-" + PurchaseOrderMsg(OrderProcess.ID) + ".xml";
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Note

The first line constructs a new message from the original one that we received. The second line sets the OutboxFileName property for the StsDefaultPipelines pipeline to a file name composed of "PurchaseOrder-" with the purchase order ID appended to it.

9.
Click OK.

10.
On the File menu, click Save All.


What did I just do?

In this step, you set the file name for messages sent to the BAS site Inbox.

Next Steps

You build and deploy the OrderProcess solution in Step 7: Build and Deploy the Solution.
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Time to complete: 10 minutes

Objective: In this step, you build and deploy the OrderProcess solution.

Purpose: Build the project to generate an assembly, and then deploy the assembly so that it is added to the global assembly cache and the BizTalk Management database. 
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Note

The BizTalk Management database is also referred to as the BizTalk Configuration database.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 6: Set the File Name for the Inbox Message.


You must log on as a member of the BizTalk Server Administrators group.
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To verify that the key file is set for the assembly

	1.
Click Start, point to Programs, point to Microsoft Visual Studio 2005, and then click Microsoft Visual Studio 2005.

2.
In Visual Studio, on the File menu, point to Open, and then click Project/Solution. 

3.
In the Open Project dialog box, browse to C:\Tutorial\Lessons\BAS\OrderProcess\, click OrderProcess.sln, and then click Open.

4.
In Solution Explorer, right-click OrderProcess, and then click Properties. 

5.
In the OrderProcessProperty Pages dialog box, on the Assembly tab, scroll down to Assembly Key File and verify that it is set to C:\Tutorial\Tutorial.snk.

If the Assembly Key File is not set to C:\Tutorial\Tutorial.snk, do the following:


Select Assembly Key File, and then click the ellipsis button (…).


In the Assembly Key File dialog box, browse to C:\Tutorial, click Tutorial.snk, and then click Open.

6.
Click OK.

7.
On the File menu, click Save All. 
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To build and deploy the project

	1.
In Solution Explorer, right-click Solution 'OrderProcess', and then click Build Solution. 

2.
In Solution Explorer, right-click OrderProcess, and then click Deploy.
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Note

You can use the Task List pane to see any errors and warnings that occur when you build the project. To add the Task List pane, on the View menu, click Task List. In the Task List pane, double-click a task to go to the location of the error or warning in the project.
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To verify the roles have been deployed to the BizTalk Management database

	1.
On the View menu, click BizTalk Explorer.

2.
In BizTalk Explorer, expand <servername>.BizTalkMgmtDb.dbo, right-click <servername>.BizTalkMgmtDb.dbo, and then click Refresh.

3.
Expand Roles to verify that five roles were added to the BizTalk Management database when you deployed the assembly.

The roles you created are:


Microsoft.BizTalk.KwTpm.BasParameterLT.ParameterConsumer


OrderProcess.PurchasingType.Buyer


OrderProcess.PurchasingType.Seller


OrderProcess.receiveBusinessDocumentsLT.receiver


OrderProcess.sendBusinessDocumentsLT.sender 

After you deploy the assembly, you can discover the assembly strong name.
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To discover the assembly strong name of the current assembly

	1.
Click Start, point to Program Files, point to BizTalk Server 2006, and then click BizTalk Server Administration. 

2.
In the console tree on the left side of the BizTalk Server Administration console, expand BizTalk Server 2006 Administration, expand BizTalk Group, expand Applications, expand BizTalk Application 1, and then click Resources.

3.
In the Resources results pane, expand the name column so that you can see the entire contents. 

4.
In the OrderProcess row, find the value for the PublicKeyToken property. In the following example:

OrderProcess, Version=1.0.0.0, Culture=neutral, PublicKeyToken=51bf5941723a688d

The value of the public key token is 51bf5941723a688d.
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Important

The public key token will be different on your computer.
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Note

You can use CTRL+C to copy the entire selected row to use in the following procedure. Paste the row into Notepad, and then copy the public key token so that you can paste it into the ParamRequestMsg message.
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To update the ParamRequestMsg Message

	1.
In Orchestration Designer, on the design surface, in the Construct request to retrieve structured parameter value shape, double-click Initialize ParamRequestMsg to open BizTalk Expression Editor.

2.
In BizTalk Expression Editor, replace each instance of xxxxxxxxxxxxxxxx with the value of the public key token that you obtained in the previous procedure.

3.
Click OK to close the Expression Editor.

4.
On the File menu, click Save All.

5.
Build and deploy the project and solution again.


What did I just do?

In this step, you built and deployed the OrderProcess solution.

Next Steps

You use the BAS portal site to create the trading partner relationship in Lesson 4: Create the Trading Partner Relationship.

See Also
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You use the BAS portal site to create the trading partner relationship. You start by creating a self profile for your organization and a partner profile for your partner. The profiles contain information about both business entities. Your self profile contains information about your organization that you want to share with a partner. A partner profile contains information about the partner organization, and information about how you will communicate with the partner. 

When you create and activate an agreement between your self profile and a partner profile, you begin the trading partner relationship. 

In this Section


Step 1: Create the Self Profile

Step 2: Create the Partner Profile

Step 3: Associate Messages with a Template

Step 4: Create and Activate the Partner Agreement

Step 5: Configure and Start the Application

Step 6: Test the Scenario
Step 1: Create the Self Profile             
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Time to complete: 4 minutes

Objective: In this step, you use the Business Activity Services (BAS) Web site to create a self profile. 

Purpose: You use the self profile to store information about your organization that you want to share with a partner. The self profile allows you to identify internally your business or different departments within your business.

You define a partner profile in Step 2: Create the Partner Profile. You create an agreement between the self profile you create in this step and the partner profile you create in step 2 in Step 4: Create and Activate the Partner Agreement.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Lesson 3: Create the Messages and Expressions.


You must log on as a member of one of the following groups:


BAS Business Users 


BAS Business Managers


BAS Administrators
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To create a self profile

	1.
Click Start, point to Programs, point to Microsoft BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click My Profiles.

3.
On the My Profiles page, click New Profile.

4.
In the My Profile template, on the GeneralInformation tab, do the following:

Use this

To do this

Partner Name
Type My profile.
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Note

You can create many self profiles for your organization. You can use different self profiles for different business relationships. For example, each self profile can contain a different set of customized contact information.

Description
Type This is a profile for my company.

The following figure shows the My Profile template.
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5.
Click Submit Profile to upload the information to the Trading Partner Management database, and to store the profile in the BAS site. 

6.
In the profile submitted successfully message box, click OK.

The My Profiles page refreshes automatically to show the new self profile.


What did I just do?

In this step, you used the Business Activity Services (BAS) Web site to create a self profile.

Next Steps

You use the BAS Web site to create a partner profile in Step 2: Create the Partner Profile.

See Also

Lesson 4: Create the Trading Partner Relationship
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[image: image108.png]Step 2




Time to complete: 12 minutes

Objective: In this step, you use the Business Activity Services (BAS) Web site to create a partner profile.

Purpose: You use the partner profile to store information about a partner. This information allows BAS to automatically generate the necessary physical ports for the partner, and establish and maintain the relationship with the partner.

The partner profile contains preferences for your partner's organization, including the global ports that the partner uses to receive information from you. You create an agreement between the self profile you created in step 1 and the partner profile you create in this step in Step 4: Create and Activate the Partner Agreement. 
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Note

The fields in the Partner Profile template change as you perform the tasks in this procedure. You must complete the steps of the procedure in the order in which they appear to ensure that the correct fields are available.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 1: Create the Self Profile.


You must log on as a member of one of the following groups:


BAS Business Users 


BAS Business Managers


BAS Administrators
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To create a partner profile

	1.
Click Start, point to Programs, point to BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click Partner Profiles.

3.
On the Partner Profiles page, click New Partner.

4.
In the Partner Profile template, on the GeneralInformation tab, in the Partner Name box, type Partner1, and then click Insert Custom Property.
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Note

Type the partner name as shown without spaces.

The following figure shows the Partner Profile template.
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The following figure shows the Partner Profile template with the custom property fields.
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5.
In the Custom properties section, click the Property qualifier ellipsis […].

The following figure shows the Select Property dialog box.
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6.
In the Select Property dialog box, from the Select property list, select Windows User, and then click OK.
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Note

InfoPath marks the property qualifier, WindowsUser, as a spelling error. 

7.
In the Custom properties section, do the following:

Use this

To do this

Property value
Type <ServerName or DomainName>\<UserName>
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Note

This is the currently logged-on user ID. If you are using Binary collation, you must capitalize <ServerName or DomainName>. For information about collations, see the "Selecting Collations" topic in SQL Server Books Online.

Run-time process property
Select the check box to make the property available to BizTalk Server.
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To configure a port for the partner profile

	1.
In the Partner Profile template, on the Advanced tab, click Insert global port, and then do the following:

Use this

To do this

Global port name 
Type Partner1DestinationPort.

Choose BizTalk send port
Right-click Choose BizTalk send port, and then click Specify port configuration.
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Note

Choose BizTalk send port changes to Configure port.

The following figure shows the Choose BizTalk send port shortcut menu.
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2.
In the Configure port section, click the Send Pipeline ellipsis […].

The following figure shows the Select Send Pipeline dialog box.
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3.
In the Select Send Pipeline dialog box, select Microsoft.BizTalk.DefaultPipeLines.XmlTransmit, and then click OK.

4.
In the Configure port section, do the following:

Use this

To do this

Retry Count
Type 3.

Retry Interval
Type 5.

Transport Type
From the drop-down list, select FILE.

Destination Location
Type C:\Tutorial\Filedrop\Partner1.

File Name
Type Confirmation%MessageID%.xml.

The following figure shows the configured port.
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5.
Click Submit Profile to upload the information to the Trading Partner Management database, and to store the profile in the BAS site. 

6.
In the profile submitted successfully message box, click OK.

You must deploy the partner profile before you can associate it with an agreement.
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To deploy the partner profile

	1.
On the Partner Profiles page, point to Partner1, and from the drop-down list, select Deploy Partner.

The following figure shows the partner drop-down list.
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2.
On the Deploy Partner page, select the BizTalk Integration Server option, and then click Deploy.
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Note

If you click the BizTalk Integration Server link, you will see the server registration information you entered in Lesson 1, step 1.

The following figure shows the Deploy Partner page.
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What did I just do?

In this step, you used the Business Activity Services (BAS) Web site to create a partner profile.

Next Steps

You upload templates for the partner to the BAS site in Step 3: Associate Messages with a Template.

See Also
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Step 3: Associate Messages with a Template
Step 4: Create and Activate the Partner Agreement
Step 5: Configure and Start the Application
Step 6: Test the Scenario
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Time to complete: 3 minutes

Objective: In this step, you upload templates for the partner.

Purpose: You can upload InfoPath document templates to partner templates. This allows all outgoing and incoming messages to be automatically associated with InfoPath templates.

In this procedure, you upload the following templates:


Purchase order


Confirmation

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 2: Create the Partner Profile.


You must log on as a member of one of the following groups:


BAS Business Users 


BAS Business Managers


BAS Administrators
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To upload the document templates

	1.
Click Start, point to Programs, point to BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click Partner Profiles.

3.
On the Partner Profiles page, in the Partner1 row, click Templates.  

4.
On the Partner1 page, click Upload Documents.

5.
On the Partner1: Upload Document page, click Upload Multiple Files. 

6.
In the tree control, navigate to C:\Tutorial\Lessons\BAS\PO Template\, select the check boxes for PurchOrd.xsn and Confirmation.xsn, and then click Save and Close. 

7.
In the confirmation message, click OK.

8.
On the Partner1 page, from the Confirmation drop-down list, select Edit Properties.

9.
On the Partner1Confirmation properties page, do the following:

Use this

To do this

Name
Type Confirmation.

Namespace
Type http://OrderProcess.Confirmation.

10.
Click Save and Close.

11.
On the Partner1 page, from the PurchOrd drop-down list, select Edit Properties.

12.
On the Partner1Confirmation properties page, do the following:

Use this

To do this

Name
Type PurchOrd.

Namespace
Type http://OrderProcess.PurchaseOrder.

13.
Click Save and Close.


What did I just do?

In this step, you uploaded templates for the partner.

Next Steps

You create an agreement using the self profile and partner profile that you created in steps 1 and 2 in Step 4: Create and Activate the Partner Agreement.

See Also

Lesson 4: Create the Trading Partner Relationship
Step 1: Create the Self Profile
Step 2: Create the Partner Profile
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Step 5: Configure and Start the Application
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Time to complete: 5 minutes

Objective: In this step, you create an agreement using the self profile and partner profile that you created in steps 1 and 2.

Purpose: A partner agreement links a partner profile to a self profile. You must define at least one addendum, which is specific to an orchestration and defines the business relationship between the partners. Each business process requires a separate addendum. A single agreement can have multiple addendums.

You create an addendum within the agreement by using the Purchasing relationship (role link type) you created in Lesson 2. The agreement template shows both the buyer and seller roles in the relationship. You must map the agreement to the global port you defined in the partner profile before you can activate the agreement. When you activate the agreement, BizTalk Server writes the agreement details, including profile and port information, to the BizTalk Management database.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 3: Associate Messages with a Template.


You must log on as a member of one of the following groups:


BAS Business Managers


BAS Administrators
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Note

Members of the BAS Business Users group can create agreements. Members of the BAS Business Users group cannot activate agreements.
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To create the agreement

	1.
Click Start, point to Programs, point to BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click Partner Profiles.

3.
On the Partner Profiles page, point to Partner1, and from the drop-down list, select New Agreement.

4.
In the Agreement template, on the GeneralInformation tab, in the Agreement name box, type Partner1 Purchasing Agreement.

5.
In the Select self profile section, click the Profile name ellipsis […].

6.
In the Select My Profile dialog box, from the Select my profile list, select My Profile, and then click OK.
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Note

Because you are creating the agreement for Partner1, Partner1 is already selected as the partner profile for the agreement.

7.
In the Agreement template, on the Addendums tab, do the following:

Use this

To do this

Addendum name
Type Partner1 Purchasing Addendum.

Business relationship name
Click the ellipsis […]. In the Select Relationship dialog box, select OrderProcess.PurchasingType, and then click OK.

MinPOAmount
Type 100.

[image: image135.png]


Note

As is defined in the orchestration, if incoming purchase orders are below this value, a negative acknowledgment is sent to the partner. Otherwise a confirmation message is sent to the partner.

DiscountRate
Type 10.
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Note

You created an expression that converts the DiscountRate value into a percentage in Step 5: Create the Calculate PO Info Expression.

8.
Click Submit Agreement.

9.
In the agreement submitted successfully message box, click OK.


[image: image137.png]


To activate the partner agreement

	1.
On the Business Activity Services site home page, click Agreements.

2.
On the Agreements page, point to Partner1 Purchasing Agreement, and from the drop-down list, select Activate Agreement.

3.
In the Activate Agreement template, on the General Information tab, do the following:

Use this

To do this

NegativeAckOperation port
Click the ellipsis […]. In the Select Port dialog box, in the Select port list, select Partner1DestinationPort, and then click OK.

ConfirmationOperation port
Click the ellipsis […].In the Select Port dialog box, in the Select port list, select Partner1DestinationPort, and then click OK.

4.
Click Submit Mapping.

5.
In the agreement mapping submitted successfully message box, click OK.

Submitting the mapping for the agreement activates the agreement. Activating the agreement writes the agreement and profile data, including port information, to the BizTalk Management database. After you submit the agreement mapping, you can access the agreement and profile data in both the BizTalk Server Administration console and BizTalk Explorer.


What did I just do?

In this step, you created and activated a partner agreement.

Next Steps

You use the BizTalk Server Administration console to create an HTTP receive location for accepting purchase order documents from the buyer in Step 5: Configure and Start the Application.
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Time to complete: 12 minutes

Objective: In this step, you use the BizTalk Server Administration console to create an HTTP receive location for accepting purchase order documents from the buyer.

Purpose: You bind the order process orchestration to the HTTP receive port and the STS.Outbox receive port, and you start the order process orchestration.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 4: Create and Activate the Partner Agreement.


You must log on as a member of the BizTalk Server Administrators group.
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To configure BizTalk Application 1

	1.
Click Start, point to Program Files, point to Microsoft BizTalk Server 2006, and then click BizTalk Server Administration. 

2.
In the console tree on the left side of the BizTalk Server Administration console, expand BizTalk Server 2006 Administration, right-click BizTalk Group, and then click Refresh.

3.
Expand BizTalk Group, expand Applications, right-click BizTalk Application 1, and then click Configure. 

4.
In the Configure Application dialog box, on the OrderService tab, do the following:

Use this

To do this

Host
From the drop-down list, select BizTalkServerApplication.

_Purchasing_SellerPortType row

From the ReceivePorts drop-down list, select New receive port.

5.
In the ReceivePort1 - Receive Port Properties dialog box, on the General tab, do the following:

Use this

To do this

Name
Type OrderProcessReceivePort.

Authentication
Select the Keep messages if authentication fails option.
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Note

This means that unauthenticated messages are stored in a Suspended queue rather than consumed.

6.
In the ReceivePort1 - Receive Port Properties dialog box, on the Receive Locations tab, click New.

7.
In the ReceiveLocation1 - Receive Location Properties dialog box, on the General tab, do the following:

Use this

To do this

Name
Type orderprocessHTTPLocation.

Type
From the drop-down list, select HTTP, and then click Configure.

8.
In the HTTP Transport Properties dialog box, do the following:

Use this

To do this

Virtual directory plus ISAPI extension
Type /HTTPReceive/BTSHTTPReceive.dll?Order.

Public address
Type HTTP://<ServerName>/HTTPReceive/BTSHTTPReceive.dll?Order.

9.
Click OK.

10.
In the orderprocessHTTPLocation -Receive Location Properties dialog box, on the General tab, do the following:

Use this

To do this

Receive Handler
From the drop-down list, select BizTalkServerIsolatedHost.

Receive Pipeline
From the drop-down list, select XMLReceive [Microsoft.BizTalk.DefaultPipelines.XMLReceive, Microsoft.BizTalk.DefaultPipelines, Version=3.0.1.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35].

11.
Click OK.

12.
In the OrderProcessReceivePort - Receive Port Properties dialog box, click OK.

13.
In the Configure Application dialog box, on the OrderService tab, on the _ReceiveDocumentsFromOutbox_receiveFromOutboxPT row, from the ReceivePorts drop-down list, select Sts.Outbox, and then click OK.

14.
In the console tree, expand BizTalk Application 1, and then click Orchestrations.

15.
In the orchestrations results pane, right-click OrderProcess.OrderService, and then click Enlist.

16.
In the orchestrations results pane, right-click OrderProcess.OrderService, and then click Start.

17.
In the console tree, expand BizTalk Application 1, and then click Receive Locations.

18.
In the receive locations results pane, right-click orderprocessHTTPLocation, and then click Enable.


What did I just do?

In this step, you used the BizTalk Server Administration console to create an HTTP receive location for accepting purchase order documents from the buyer.

Next Steps

You test the orchestration process and business policy execution as defined within Business Activity Services (BAS) in Step 6: Test the Scenario.
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Time to complete: 7 minutes

Objective: In this step, you test the orchestration process and business policy execution as defined within Business Activity Services (BAS).

Purpose: The batch file simulates sending messages to the Outbox. While a message remains in the Outbox, the message's status property updates. The messages remain in the Outbox until the orchestration sends a "receipt" to Sent Items. After the orchestration sends the receipt, the messages move from the Outbox to the partner's Sent Items folder.
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Note

You must complete this step before you begin Tutorial 5: Business Activity Monitoring.

Prerequisites

Note the following requirements before you begin this step:


Before you begin this step you must complete Step 5: Configure and Start the Application. 


You must log on as a member of the BizTalk Server Administrators group.
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To run the scenario

	1.
In Windows Explorer, browse to C:\Tutorial\Lessons\BAS\HttpPost, and then double-click HttpPost.sln to open it in Visual Studio 2005.

2.
In Visual Studio, on the Build menu, click Configuration Manager.

3.
In the Configuration Manager dialog box, from the Active Solution Configuration drop-down list, select Release, and then click Close.

4.
On the Build menu, click Build Solution.

5.
Close Visual Studio 2005.

6.
In Windows Explorer, browse to C:\Tutorial\Lessons\BAS, and then double-click SubmitOrder.bat to run the batch file, which posts a purchase order document to the orchestration. 
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Note

The command window remains on your screen so you can view any script errors. If the script ends with DONE, it completed successfully. If not, correct any issues and run the script again. You must press any key to end the script and close the command window.
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To check the BAS Inbox

	1.
Click Start, point to Programs, point to Microsoft BizTalk Server 2006, and then click Business Activity Services Site.
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Note

If you are not working on the computer where BizTalk Server is installed, you can access the BAS site remotely. In Microsoft Internet Explorer, type http://<ServerName>/sites/BASSite, and then press ENTER.

2.
On the Business Activity Services site home page, click Partner Profiles.

3.
On the Partner Profiles page, in the Partner1 row, click Inbox.
The Partner1 Inbox page displays all documents received by the seller from Partner1. If the Partner1 Inbox page does not show the incoming purchase order document, you may need to refresh the browser.

4.
On the Partner1 Inbox page, click the <purchase order document> to open the form.
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To confirm the purchase order

	1.
In the PurchaseOrder template, in the right pane, click Confirm Purchase Order.  

2.
On the PurchaseOrder Confirmation page, scroll down to the Itemized List section, in the ConfirmQuantity box (the field has a red asterisk (*)), type 8888, and then press TAB.

The purchase order totals are calculated.

3.
Click Submit. 
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Note

This saves the document into your BAS Outbox and closes the PurchaseOrder Confirmation page. Alternatively, you can save the document to your local computer and then upload it yourself into the Outbox in your BAS Web site. The message remains in the Outbox until your orchestration sends the receipt to Sent Items. After the orchestration sends the receipt, the message is moved from the Outbox to the partner's Sent Items folder. 
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To verify sent items

	1.
On the Business Activity Services site home page, click Partner Profiles.

2.
On the Partner Profiles page, on the Partner1 row, click Sent Items. 
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Note

The Partner1 Sent Items page displays all documents sent by the seller to the trading partner. If the Partner1 Sent Items page does not show the confirmed purchase order document, you may need to refresh the browser. 

3.
In Windows Explorer, browse to the C:\Tutorial\Filedrop\Partner1 folder to verify that a confirmation message is present.

If no message arrives in this folder, verify that the account running your BizTalk Host has sufficient permissions to this directory.


What did I just do?

In this step, you tested the orchestration process and business policy execution as defined within BAS.

Next Steps

You set up BizTalk Server 2006 Business Activity Monitoring (BAM) to track the performance of the Order Process business solution in Tutorial 5: Business Activity Monitoring.
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